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Chapter

1

Introducing the Veritas
High Availability Agent for
SAP WebAS
This chapter includes the following topics:
■

About the High Availability agent for SAP WebAS

■

What’s new in this release

■

Supported software

■

How the agent makes SAP WebAS highly available

■

Agent functions

■

Typical SAP WebAS configuration in a VCS cluster

■

Setting up SAP WebAS in a VCS cluster

About the High Availability agent for SAP WebAS
The Veritas High Availability agents monitor specific resources within an
enterprise application, determine the status of these resources, and start or stop
them according to external events.
The Veritas High Availability agents monitor specific resources within an
enterprise application. They determine the status of resources and start or stop
them according to external events.
The Veritas agent for SAP WebAS provides high availability for SAP NetWeaver
7.1 in a cluster. The agent for SAP WebAS is designed to support a wide range of
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SAP NetWeaver environments which include SAP NetWeaver CE 7.1, SAP
NetWeaver Mobile 7.1, and SAP NetWeaver PI 7.1.
See the following Technical Support TechNote for the latest updates or software
issues for this agent:
http://seer.entsupport.symantec.com/docs/282004.htm
The Veritas agent for SAP WebAS brings SAP instances online, monitors the
instances, and bring the instances offline. The agent monitors the system processes
and server states, and can shutdown the server in case of a failover.
The agent supports the following SAP instance types:
■

Central Services Instance

■

Application Server Instance

■

Enqueue Replication Server Instance

The agent supports the following SAP Web Application Server Usage Types:
■

ABAP

■

Java

■

Add-In (ABAP + Java)

What’s new in this release
The following change was made for this release:
■

Enhanced second level monitoring for SAPWeb Application server as Java.
Now the agent uses sapcontrol.exe utility provided by SAP to check the status
of application server running as Java.

Supported software
The Veritas agent for SAP WebAS is supported in the following environments:
Veritas Cluster VCS 5.0, 5.1, 5.1SP1
Server
Note: In the software disc, no separate agent is provided for VCS 5.1 and
5.1SP1. For VCS 5.1 and 5.1SP1 use the agent provided for VCS 5.0
Operating
Systems

SAP WebAS

■

Microsoft Windows Server 2003 (x64)

■

Microsoft Windows Server 2003 (IA64)

■

Microsoft Windows Server 2008 (x64)

7.1
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SAP
Applications

NetWeaver PI 7.1, Mobile 7.1, and CE 7.1

Note: All Enhancement Packages (EhP) for PI 7.1, Mobile 7.1 and CE 7.1
are supported.

How the agent makes SAP WebAS highly available
The Veritas agent for SAP WebAS continuously monitors the SAP instance
processes to verify that they function properly.
The agent provides the following levels of application monitoring:
■

Primary or Basic monitoring
This mode has Process check and Health check monitoring options. With the
default Process check option, the agent verifies that the SAP instance processes
are present in the process table. Process check cannot detect whether processes
are in hung or stopped states.

■

Secondary or Detail monitoring
In this mode, the agent runs a utility to verify the status of SAP instance. The
agent detects application failure if the monitoring routine reports an improper
function of the SAP instance processes. When this application failure occurs,
the SAP instance service group fails over to another node in the cluster.
Thus, the agent ensures high availability for SAP instance.

Agent functions
Online
The online function performs the following tasks:
■

Validates the values of the agent attributes required to bring the SAP instance
online.

■

Performs a preliminary check to ensure that the SAP instance is not running
already on the specified node in the cluster.

■

Starts the SAP Windows service SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■

Starts the SAP instance using the startsap.exe utility.

■

Ensures that the instance is initialized successfully.
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Offline
The offline function performs the following tasks:
■

Validates the values of the agent attributes required to bring the SAP instance
offline.

■

Performs a preliminary check to ensure that the SAP instance is not already
offline.

■

Stops the SAP instance using the stopsap.exe utility.

■

Stops the SAP Windows service. SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■

Kills any remaining SAP instance processes to ensure that the instance
processes are removed completely.

Monitor
The monitor function performs the following tasks:
■

Validates the values of the agent attributes required to monitor the SAP
instance.

■

Performs a first-level monitor check as follows:

■

■

The function verifies that the SAP Windows service SAPSAPSID_InstID is
running, where InstID is the last two characters of the InstName attribute.

■

Verifies that all processes that the ProcMon attribute lists are running.

If the value of SecondLevelMonitor attribute is greater than 0, the monitor
function performs a more thorough check of the SAP instance as follows:
■

For APPSERV instances, the function uses the following utilities to perform
this check:
Server type

SAP utility used

SAPWeb Application
Server as ABAP

sapinfo.exe

SAPWeb Application
Server as Java

sapcontrol.exe

SAPWeb Application
Server as Add-In

sapinfo.exe and sapcontrol.exe
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■

For an Enqueue or Enqueue Replication server instance, the function uses
the ensmon.exe utility.

■

If the MonitorProgram attribute specifies a custom monitor program, the
monitor function executes the specified program.
See “Executing a custom monitor program” on page 57.

■

Uses SAP’s sapsrvkill.exe utility to stop all processes of the particular SAP
instance.

■

Stops SAPSAPSID_InstID, the SAP Windows service for the instance.

■

The clean function identifies and kills any remaining SAP instance processes
using the unique combination of the SAPSID attribute and InstID, that is the
last two characters of the InstName attribute. All these processes must also
belong to the SAPServiceSAPSID or sapsidadm user.

Clean

Typical SAP WebAS configuration in a VCS cluster
A typical SAP WebAS configuration in a VCS cluster has the following
characteristics:
■

VCS is installed and configured in a two-node cluster.

■

The SAP WebAS instance binaries are installed locally on both nodes or on
shared disks.

■

The Veritas agent for SAP WebAS is installed on the both nodes.

■

The drive:\usr\sap directory is shared with name sapmnt and saploc.

15

16

Introducing the Veritas High Availability Agent for SAP WebAS
Typical SAP WebAS configuration in a VCS cluster

Figure 1-1

depicts a configuration where SAP WebAS instance binaries and
SYS are installed completely on shared disks.
Node 2

Node 1
VCS Private Network

Shared disks / diskgroups

SAP instance binaries and
SYS on shared disks

Public Network
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Figure 1-2
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depicts a configuration where SAP WebAS instance binaries are
installed locally on each node and SYS is installed on shared disks.

Node 1

Node 2
VCS Private Network

SAP instance binaries

Shared disks / diskgroups
SAP instance binaries

SYS on shared disks

Public Network

Setting up SAP WebAS in a VCS cluster
Follow the steps below to set up SAP WebAS in a cluster:
■

Set up a VCS cluster.
Refer to Veritas Storage Foundation™ and High Availability Solutions
Installation and Upgrade Guide for more information on installing and
configuring VCS.

■

Install and configure SAP WebAS for High Availability.

■

Install the Veritas High Availability agent for SAP WebAS.
See “Installing the VCS agent for SAP WebAS” on page 45.

■

Configure the service groups for SAP WebAS.
See “About configuring service groups for SAP WebAS” on page 59.
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Chapter

2

Installing and configuring
the SAP WebAS for high
availability
This chapter includes the following topics:
■

About SAP Web Application Server

■

Uniquely identifying SAP WebAS server instances

■

Monitoring an SAP instance

■

About installing SAP WebAS for high availability

■

About configuring SAP WebAS for high availability

■

Setting up SAP systems for clustering

■

Installing SAP system using Virtual Hostname

■

Configuring the SAP WebAS agent for message server restart

■

Configuring the Enqueue Replication Server for SAP WebAS

■

Clustering an SAP instance

■

Configuring the SAP systems on Windows Server 2008

About SAP Web Application Server
All SAP NetWeaver components (example, PI, CE) run on top of the SAP Web
Application Server.
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The following three usage types are possible with SAP WebAS:
■

SAP WebAS ABAP (ABAP only)

■

SAP WebAS Java (Java only)

■

SAP WebAS Add-In (ABAP and Java)

Depending on the SAP NetWeaver component to be installed, the Web Application
Server installation type is determined. For example, SAP NetWeaver PI requires
SAP WebAS Add-In (ABAP + Java) usage type.

SAP system components
An SAP application instance has multiple services or components which are
typically deployed across multiple servers.
SAP identifies the following services as critical to the application environment,
representing potential single points of failure:
■

Database Instance

■

Central Services Instance (SCSxx or ASCSxx)

■

Enqueue Replication Server (ERSxx)

■

Network File System (NFS) or Common Internet File System (CIFS) services

Where xx takes the value of an SAP Instance number ranging from 00 to 99.

SAP architecture
Table 2-1 lists the different SAP architectures and its components.
Table 2-1

SAP architecture

Architecture

Component

Service

Functions

SAP WebAS ABAP

Application Server

ABAP Dispatcher

■

Controls program that manages the
resources of the R/3 applications.
■ Balances assignment of the transaction
load to the work processes.
■ Manages buffers in main memory.
Manages connections with the
presentation level.
■ Organizes the communication processes.
■
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Table 2-1
Architecture

Component

Central Services
Instance

SAP architecture (continued)
Service

Functions

ABAP Work
processes

■

ABAP Enqueue
Service

■

Manages logical locks.

■

Ensures server synchronization.

ABAP Message
Service

■

Enqueue Replication ABAP Enqueue
Instance
Replication Service
SAP WebAS Java

Acts as a service offered by a server and
requested by a client
■ Acts as a special program in charge of
some specific tasks.

Central service for cluster internal
communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher.
■ Keeps a list of application servers that can
be reached within the system.
Enables the lock table to be replicated on a
second server, the replication server.

Application Server

Java Server Processes Processes the requests and holds the session
data.

Central Services
Instance

Java Enqueue Service ■ Manages logical locks.
■

Ensures server synchronization.

Java Message Service ■ Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher.
■ Keeps a list of application servers that can
be reached within the system.
Enqueue Replication Java Enqueue
Instance
Replication Service

Enables the lock table to be replicated on a
second server, the replication server.
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Table 2-1

SAP architecture (continued)

Architecture

Component

Service

Functions

SAP WebAS Add-In

Application Server

ABAP Dispatcher

■

ABAP Work
processes

Controls program that manages the
resources of R/3 applications.
■ Balances the assignments of the
transaction load to the work processes.
■ Manages buffer in main memory.
■

Connects to the presentation level.

■

Organizes the communication processes.

Acts as a service offered by a server and
requested by a client.
■ Manages the programs that handle
specific tasks.
■

Java Server Processes ■ Handles the client-server processes and
maintains the session data.
Central Services
Instance ABAP

Central Services
Instance Java

ABAP Enqueue
Service

■

Manages logical locks

■

Ensures server synchronization

ABAP Message
Service

■

Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher
■ Keeps a list of application servers that can
be reached within the system.

Java Enqueue Service ■ Manages logical locks.
■

Ensures server synchronization.

Java Message Service ■ Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher
■ Keeps a list of application servers that can
be reached within the system.
Enqueue Replication ABAP Enqueue
Instance ABAP
Replication Service

Enables the lock table to be replicated on a
second server, the replication server.
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Table 2-1
Architecture

Component

SAP architecture (continued)
Service

Functions

Enqueue Replication Java Enqueue
Instance Java
Replication Service

Enables the lock table to be replicated on a
second server, the replication server.

Single Point of Failures (SPOF)
In a distributed SAP environment, the following components are critical for
application availability. Hence, these components need to be protected.
■

Database Instance

■

Central Services Instance

■

Enqueue Replication Server

Table 2-2 lists the possibilities to eliminate the single point of failures.
Table 2-2

Possibilities to secure the single point of failures

Single Point of Failure

Technical Possibilities to eliminate the SPOF

Central Database

Switch-over solutions

Central Services

Set up an Enqueue Replication Server controlled by
a switch-over solution

Enqueue Replication Server

Switch-over solutions

SAP Central File System

Switch-over solutions

Uniquely identifying SAP WebAS server instances
You can virtualize an SAP instance using a cluster. Using shared disk and virtual
IP addresses, you can manage a large set of SAP WebAS instances in a single
cluster.
For multiple instances running concurrently on a single node, the agent must be
able to uniquely identify each SAP WebAS instance on that system.
Each instance has a unique instance name. The instance names may follow the
conventional form. For example, additional application server instances begin
with 'D', and Primary application server instances are typically named DVEBMGS.
Instance names often include an instance ID suffix which is an integer between
00-99. For example, an application server instance with an instance ID = 00 may
have an instance name of DVEBMGS00.
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The SAPSID and InstName form a unique identifier that can identify the processes
running for a particular instance.
Some examples of SAP instances are given as follows:
InstName

InstType

DVEBMGS00

SAP Application Server - ABAP (Primary)

D01

SAP Application Server - ABAP (Additional)

ASCS02

SAP Central Services - ABAP

J03

SAP Application Server - Java

SCS04

SAP Central Services - Java

ERS05

SAP Enqueue Replication Server

Differentiating SAP instances is important to identify each instance uniquely.
When the agent kills the processes of a non-responsive or failed instance in absence
of unique names for each server, the agent may kill processes for more than one
SAP instance during a clean operation.

Monitoring an SAP instance
The monitor operation performs process level check to ensure the proper
functioning of an SAP instance.
The ProcMon attribute specifies the processes that must be running successfully
for a particular SAP instance type. The monitor operation uses this list of processes
to scan the process table, and verify that the processes are running successfully.
Table 2-3 lists valid values of the ProcMon attribute
Table 2-3

Values of ProcMon attribute

SAP usage type

SAP instance type

Value of ProcMon
attribute

ABAP

ENQREP

enrepserver.exe

Java

APPSERV

jstart.exe
igswd.exe and icman.exe are
optional

Installing and configuring the SAP WebAS for high availability
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Table 2-3

Values of ProcMon attribute (continued)

SAP usage type

SAP instance type

Value of ProcMon
attribute

Java

ENQUEUE

enserver.exe
msg_server.exe
gwrd.exe is optional

Java

ENQREP

enrepserver.exe

Add-In (ABAP + Java)

APPSERV

disp+work.exe
jstart.exe
igswd.exe, icman.exe and
gwrd.exe are optional

Add-In (ABAP +Java)

ENQUEUE (ABAP)

enserver.exe
msg_server.exe

Add-In (ABAP +Java)

ENQREP (ABAP)

enrepserver.exe

Add-In (ABAP +Java)

ENQUEUE (Java)

enserver.exe
msg_server.exe
gwrd.exe is optional

Add-In (ABAP +Java)

ENQREP (Java)

enrepserver.exe

The monitor operation takes a snapshot of the running processes table. The
operation compares the processes that the ProcMon attribute specifies, to the set
of running processes. If any process is missing, the operation declares the SAP
instance as offline, and bypasses further monitor operations.

About installing SAP WebAS for high availability
You can install SAP NetWeaver 7.10 in the following ways, in a VCS environment:
SAP instance on shared disk

Install the SAP instance binaries and SYS directory on
shared disks

SAP instance on shared disk

Install the SAP instance binaries on local disk and SYS
directory on shared disks

When installing SAP NetWeaver, ensure that the login_name, group_name for
the sidadm and SAPServiceSID is the same on all the nodes.
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For more details refer to SAP documentation.

About configuring SAP WebAS for high availability
The guidelines for configuring SAP NetWeaver 7.10 for high availability are as
follows:
■

In a service group, keep the single point of failure as minimal as possible and
watch the application startup time.

■

Assign a virtual hostname to the component within the switchover envionment.
Since the physical hostname changes with the switchover, this is a must have
requirement.

■

Based on the expected failover time configure the reconnection parameters
for all software components and enable its automatic reconnection.

■

Configure sapcpe to copy the instance specific executables and binaries from
a central file system to the instance executable directory, during the instance
startup.

Setting up SAP systems for clustering
This topic describes the procedure to install and configure SAP NetWeaver 7.10
on a Windows system, so that you can cluster the system in a Veritas Cluster
Server (VCS) environment.
Symantec recommends installing and clustering a database server for SAP to
minimize SAP system downtime. An SAP system downtime may happen due to
database unavailability.
In this installation, it is assumed that you are setting up the system on two or
more nodes, and clustering these nodes in a VCS environment.
Note: Symantec strongly recommends that a trained SAP consultant must be
involved in performing the installation procedure.

Installing SAP system using Virtual Hostname
SAP system can be installed in HA environment directly using virtual hostnames.
To install SAP system using virtual hostname, perform the following steps:
Note: Before installing SAP system refer to SAP Installation documentation.
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To install SAP instances using Virtual Hostname

1

Log in as a user that has domain administrator rights.

2

Create a VCS Service Group with IP and Lanman resources for SAP instance.
For details about creating VCS Service Groups, refer to the VCS user
documentation.

3

Before beginning to install the SAP instance, bring the Service Group online.

4

On the node that has the Service Group online, start the SAP instance
installation.
Note: Do not double-click the sapinst.exe file to launch the SAP installation
GUI. Use the SAPINST_USE_HOSTNAME parameter to launch the SAP
installation GUI in a virtual environment.

5

Navigate to the directory where sapinst.exe tool is present in the Master DVD.
At the command prompt, run the following command:
path\sapinst.exe SAPINST_USE_HOSTNAME=Virtual Host Name

where,
Virtual Host Name is the virtual Lanman name that you created in step 2.

6

From the installation GUI, select High Availability System >Based on [AS
ABAP/AS Java/AS ABAP and AS Java] based on the usage type of system
you are planning to install and follow the instructions to complete the
installation.

Configuring the SAP WebAS agent for message server
restart
In case the message server process fails, the Veritas High Availability agent for
SAP WebAS supports the message server restart through SAP service
(SAPSID_InstID) process sapstartsrv.exe
In case of unexpected termination, to avail the advantage of this restart technology
without failing over the entire (A)SCS instance, the SAP administrator must modify
the Instance profile for (A)SCS instance and set the new profile parameters.
Note: Restart of enqueue server process "enserver.exe" is not supported by the
Veritas High Availability agent for SAP WebAS.
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To restart message server, use the following syntax in the start profile:
Restart_Program_xx = local program name program arguments

For example following is the modified syntax for message server
Restart_Program_02 = local $(_MS) pf=$(_PF)

By default sapstartsrv.exe restarts the message server without any delay.
For more information on how to restart process of a program through
sapstartsrv.exe, refer to SAP Note 729945 and related notes.
Note: Symantec recommends to carefully study the SAP note before you modify
the profile files for (A)SCS instance.

Configuring the Enqueue Replication Server for SAP
WebAS
You can either manually configure or use SAPInst to configure the Enqueue
Replication Server for SAP WebAS.

Configuring the Enqueue Replication Server manually
Perform the following steps to manually configure the Enqueue Replication Server
for SAP WebAS:
■

Enable replication in the (A)SCS instance by adding the following parameter
to the instance profile of (A)SCS instance
(SAPSID_InstName_VirtualHostname).
enque/server/replication = true

You have to restart the (A)SCS instance to make the change effective. Assume
a two-node software failover cluster (running on the physical hosts hostAand
host B) and a clustered (A) SCS instance with the following parameters.
SCS SAPSID = PLL
SCS INSTNO = 01
SCS HOST = sapscshost (virtual host name)
This instance (namely, the enqueue server’s lock table) should be protected
with an ERS instance as follows:
ERS SAPSID = PLL
ERS INSTNO = 11 (a free instance number)
ERS HOST = sapershost (virtual hostname)
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■

On one of the physical host ( host A or host B) perform the following steps as
user sidadm or domain administrator:
Create the directory structure as follows:
drive:\usr\sap\PLL\ERS11\exe
drive:\usr\sap\PLL\ERS11\log
drive:\usr\sap\PLL\ERS11\data
drive:\usr\sap\PLL\ERS11\work

■

Copy all the binaries from (A)SCS instance exe directory into the ERS instance
exe directory

■

Create a new ERS instance profile in drive:\usr\sap\PLL\SYS\profile.
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SAPSYSTEMNAME = PLL
SAPSYSTEM = 11
INSTANCE_NAME = ERS11
DIR_CT_RUN = $(DIR_EXE_ROOT)\$(OS_UNICODE)\NTAMD64
DIR_INSTANCE = <drive>:\usr\sap\$(SAPSYSTEMNAME)\$(INSTANCE_NAME)
DIR_EXECUTABLE = $(DIR_INSTANCE)\exe
DIR_PROFILE = $(DIR_INSTALL)/profile
_PF = $(DIR_PROFILE)\PLL_ERS11_sapershost
SAPGLOBALHOST = sapscshost
SAPLOCALHOST = sapershost
#---------------------------------------------------------------# Copy SAP Executables
#---------------------------------------------------------------_CPARG0 = list:$(DIR_CT_RUN)/scs.lst
Start_Program_01 = immediate $(DIR_CT_RUN)\sapcpe$(FT_EXE) pf=$(_PF)
$(_CPARG0)
#----------------------------------------------------------------# Settings for enqueue monitoring tools (enqt, ensmon)
#----------------------------------------------------------------enque/process_location = REMOTESA
rdisp/enqname = $(rdisp/myname)
#----------------------------------------------------------------# standalone enqueue details from (A)SCS instance
#----------------------------------------------------------------SCSID = 01
SCSHOST = sapscshost
enque/serverinst = $(SCSID)
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enque/serverhost = $(SCSHOST)
enque/serverport = 32$(SCSID)
enque/enrep/poll_interval = 0
enque/enrep/poll_timeout = 120
enque/enrep/inactive_action = sleep
#----------------------------------------------------------------# Start enqueue replication server
#----------------------------------------------------------------_ER = $(DIR_EXECUTABLE)\enrepserver$(FT_EXE)
Start_Program_02 = local $(_ER) pf=$(_PFL) NR=$(SCSID)

For DIR_CT_RUN in this ERS profile, take the value DIR_CT_RUN from the
(A)SCS instance profile. If the (A)SCS instance has not configured DIR_CT_RUN
in its profiles, take the value specified for DIR_EXECUTABLE from the (A)SCS
instance profile.
It is essential that the binaries from (A)SCS and ERS instance are from the
same binary set.
■

Use the sapstartsrv.exe command to create an SAP Windows Service for the
Enqueue Replication server instance.

■

Start the SAP instance for the Enqueue Replication server. Ensure that the
instance starts successfully.

■

The SAP instance is now ready for clustering and Control the life time of
Enqueue Replication Server using VCS.

Configuring the Enqueue Replication Server using SAPInst
Perform the following steps to configure the Enqueue Replication Server for SAP
NetWeaver 7.10, using SAPInst:
■

Install Enqueue Replication Server using SAPInst with virtual hostname.
# sapinst SAPINST_USE_HOSTNAME=VirtualHostName

■

Modify the Enqueue Replication Instance profile
drive:\usr\sap\SAPSID\SYS\profile\SAPSID_InstName_VHostName
■

Add the following lines under the section "standalone enqueue details from
(A)SCS instance" in the profile file.
enque/poll_interval = 0
enque/poll_timeout = 120
enque/enrep/inactive_actio = sleep
enque/table_size = 4096
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■

Delete the following lines from the profile file.
Autostart = 1
enque/enrep/hafunc_implementation

■

Change the Restart_Program_00 to Start_Program_00 Under "Start enqueue
replication server" section.
Start_Program_00 = local $(_ER) pf=$(_PFL) NR=$(SCSID)

■

Control the life time of Enqueue Replication Server using switchover
solution.

Clustering an SAP instance
This section describes the procedure for clustering an SAP instance.
To cluster an SAP instance, you must first configure the node that hosts the SAP
Central Service Instance ([A]SCS) and then configure all other nodes that you
want to cluster.

Configuring the first node in the cluster
Perform the following tasks on the node on which you installed SAP, the first
time.
■

Set the SAP Service to manual.

■

Create the cluster service group for SAP instance.

To configure the first node in the cluster

1

Stop the SAP Central Services Instance.

2

Stop the SAP instance Windows service
SAPSAPSID_No

3

In the instance profile, set the AUTOSTART equal to 0.

4

Configure the SAPSAPSID_No service as follows:
■

Open services.msc. Click Start > Run and enter service.msc.

■

On the Services panel, right-click the SAPSAPSID_No service, and select
Properties.

■

On the General tab, select Manual from the Startup type drop-down list.

■

Click OK.

■

Close and exit the Services panel.
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Configuring all other nodes in the cluster
Perform the following tasks on the other remaining cluster nodes:
■

Create the required SAP users and groups.

■

Set the system and user environment for the SAP system.

■

Enter the required port numbers in the Windows services files.

■

Install Host Agent using sapinst.exe.

■

Create the Windows service for the SAP instance.

To configure all other nodes in the cluster

1

Login as a domain administrator.

2

Create the following local groups.
■

SAP_SAPSID_LocalAdmin

■

SAP_SAP_LocalAdmin

■

SAP_LocalAdmin

3

Add the SAP_SAPSID_GlobalAdmin domain group to the
SAP_SAPSID_LocalAdmin and SAP_LocalAdmin group.

4

Add the SAP_SAP_GlobalAdmin domain group to the SAP_SAP_LocalAdmin
and SAP_LocalAdmin

5

Add the SAP_SAPSID_GlobalAdmin and SAP_SAP_GlobalAdmin domain
group to the local Administrators group.
For details on creating and adding a new local group and users:
See “Creating and adding local groups and users” on page 39.

6

Click Start > Programs > Administrative Tools > Local Security Policy >
Local Policies > User Right Assignment.

7

Add the following privileges for the sapsidadm user.

8

■

Act as a part of the Operating System (SeTcbPrivilege)

■

Replace a process-level token (SeAssignPrimaryTokenPrivilege)

■

Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

Add the following privileges for the SAPServiceSAPSID user.
■

Log on as a Service (SeServiceLogonRight).

■

Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

■

Access this computer from the network (SeNetworkLogonRight)
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■

9

Deny Logon Locally and Deny Log on through Terminal Services
(SeDenyInteractiveLogOnRight)

Change the sapsidadm user environment as follows:
■

At the command prompt enter,
runas /profile /user:domain\sapsidadm regedit

■

On the Registry Editor panel, click HKEY_CURRENT_USER >
Environment.

■

Modify the user environment based on your Database, SAP Usage Type
and SAPSID.

For example, the following table depicts the registry environment with Oracle
database (PI1) and Add-In installation with SAPSID PI1.
Name

Type

Data

Default

REG_SZ

value not set

DBMS_TYPE

REG_SZ

ora

dbs_ora_schema

REG_SZ

SAPSR3

dbs_ora_tnsname

REG_SZ

PI1

JAVA_HOME

REG_SZ

C:\j2sdk1.4.2_19-x64

NLS_LANG

REG_SZ

AMERICAN_AMERICA.UTF8

ORACLE_HOME

REG_EXPAND_SZ

E:\oracle\PI1\102

ORACLE_SID

REG_EXPAND_SZ

PI1

PATH

REG_EXPAND_SZ

E:\usr\sap\PI1\SYS\exe\uc\NTAMD64;\
\sappi1scs\sapmnt\PI1\SYS\exe\uc\NTAMD64;
E:\oracle\PI1\102\BIN

SAPDATA_HOME

REG_EXPAND_SZ

E:\oracle\PI1

SAPEXE

REG_SZ

\\sapi1scs\sapmnt\PI1\SYS\exe\uc\NTAMD64

SAPLOCALHOST

REG_SZ

sappi1aas

SAPSYSTEMNAME REG_SZ

PI1

TEMP

REG_EXPAND_SZ

E:\usr\sap\PI1\tmp

TMP

REG_EXPAND_SZ

E:\usr\sap\PI1\tmp
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Name

Type

Data

TNS_ADMIN

REG_EXPAND_SZ

\\sappi1scs\sapmnt\PI1\SYS\profile\oracle

10 From the first node in the cluster, copy the following service entries for the
SAP instance, from the services file in the %windir%\system32\drivers\etc
directory to the corresponding services file on all other nodes in the cluster.
sapdp<No.>
sapdp<No.>s
sapgw<No.>
sapgw<No.>s
sapms<SAPSID>

32<No.>/tcp
47<No.>/tcp
33<No.>/tcp
48<No.>/tcp
36<No.>/tcp

#
#
#
#
#

SAP
SAP
SAP
SAP
SAP

System
System
System
System
System

Dispatcher Port
Dispatcher Security Port
Gateway Port
Gateway Security Port
Message Port Number

where,
The value for <No.> is the value of an Instance ID.

11 Move the Service Group from the first node to the node that you are currently
configuring and ensure that the drive:\usr\sap directory is shared with the
names, sapmnt and saploc.
See “Creating sapmnt and saploc share directories” on page 40.

12 Install SAP Host Agent with SAPInst. Follow the steps below to install the
SAP Host agent.
■

In the Master DVD, navigate to the directory containing the sapinst.exe
tool.

■

Double-click the sapinst.exe file to launch the SAP installation GUI.

■

Select High Availability System > Based on [AS ABAP/AS Java/AS ABAP
and AS Java] > Host Agent based on the usage type of system you installed.

■

Follow the instructions to complete the installation.

13 Create the SAPSAPSID_No service as follows:
■

At the command prompt, navigate to the
drive:\usr\sap\SAPSID\InstName\exe directory.

■

Run the sapstartsrv.exe command.

■

In the SAP Service Install/Uninstall dialog box, enter the following values:
SID

SAPSID

NR

InstanceNumber
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Profile

If, SAPLOCALHOST=SAPGLOBALHOST, then enter the value
as:
drive:\usr\sap\SAPSID\SYS\profile\SAPSID_InstName_VirtualHostName
If, SAPLOCALHOST is not equal to SAPGLOBALHOST, then enter
the value as:
\\SAPGLOBALHOST\sapmnt\SAPSID\SYS\profile\SAPSID_InstName_VirtualHostName

User

domain\SAPServiceSAPSID

Password

SAPServiceSAPSID password

Startup type

manual

Use
domain\sapsidadm
Environment of
User

14 Click OK.
15 Reregister the type library as follows:
■

At the command prompt, navigate to the Drive:\Path\SAP\hostctrl\exe
directory.

■

Run the sapstartsrv.exe command.

■

In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field

■

Click OK.

16 Create registry entries for the SAPSAPSID_No service.
For example,
Name

Type

Data

Default

REG_SZ

value not set

EventMessageFile

REG_SZ

\\sappi1scs\sapmnt\PI1\SYS\exe\
uc\NTAMD64\sapevents.dll

TypesSupported

REG_DWORD

0x00000007(7)

17 If an SAP Microsoft Management Console (MMC) is not configured on the
node, register the SAP MMC using the following steps:
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■

Access the file sapmmcX64u.msi or sapmmcIA64u.msi from Kernel Install
DVD depending on the OS architecture.

■

Install SAP MMC by executing the msi package.

Note: Symantec recommends that you cluster the SAP Central Services instances
for both ABAP and Java in an Add-In Usage Type in the same service group.
Also, cluster the Enqueue Replication servers for both ABAP and Java in an Add-In
Usage Type in a single Service Group.

Creating and adding domain groups and users
If you do not have domain administrator rights, you can perform the SAP instance
installation and configuration as a domain user who is a member of the local
administrator group.

User accounts
The SAPInst tool creates the following accounts for the SAP system administrator:
sapsidadm

This user account is the SAP system administrator account. This
account enables interactive administration of the system.

SAPServiceSID

This user account is required to start the SAP system. This
account has the local user right to log on as a service.
This account does not allow interactive logon. You need not set
an expiry date for the password. However, you must change the
password at next logon option.

Groups
The SAPInst tool creates the following groups during domain installation:
SAP_SAPSID_GlobalAdmin This global group is a domain level SAP administration group
for organizing SAP system administrators. This global group,
groups together the users at the domain level so that they can
be placed in appropriate local groups.
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SAP_SAPSID_LocalAdmin These are Local groups created and maintained on an application
server. A local group has rights only to the system on which the
group is located.
The system on which the local group is located is part of a
particular domain. The local group can contain users and global
groups from this domain.
SAP_LocalAdmin

Though this group is created on all hosts, creating this group on
the transport host is necessary. Members of this group have full
control over the transport directory, drive:\usr\sap\trans. This
directory allows transports to take place between systems.
The SAP_SAPSID_GlobalAdmin groups of all the SAP systems
that are part of the transport infrastructure are added to the
SAP_LocalAdmin group. Therefore, the sapsidadm and
SAPServiceSAPSID users of all systems in the transport
infrastructure are members of the SAP_LocalAdmin group. These
users have the rights necessary to initiate and execute transports.

Adding new domain groups and users
This section describes the procedure to add new domain groups and users. You
can perform this procedure as a domain administrator only.
To create the SAP_SAPSID_GlobalAdmin Global group

1

Log in as a domain administrator on to Domain Controller.

2

Click Start > Programs > Administrative Tools > Active Directory Users
and Computers.
Alternatively,

3

■

Click Start > Run.

■

In the Open field, enter mmc.

■

In the Console window, click File > Add/Remove Snap-in.

■

In the Add/Remove Snap-in dialog box, click Add.

■

In the Add Standalone Snap-in dialog box, select Active Directory Users
and Computers.

■

Click Add.

■

Click OK.

In the Active Directory Users and Computers dialog box, right-click Users,
and select New > Group.
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4

In the New Object - Group dialog box, enter the following values:
Group Name

SAP_SAPSID_GlobalAdmin
Specify this value using the exact and correct uppercase
and lowercase.

5

Group scope

Global

Group type

Security

Click OK.

Creating SAP system users, sapsidadm and SAPServiceSAPSID
Follow the steps below to create the SAP system users:
To create the SAP system users

1

In the Active Directory Users and Computers dialog box, right-click Users,
and select New > User.

2

In the New Object - User dialog box, enter the following values for sapsidadm
First name

NA

Initials

NA

Last name

NA

Full name

sapsidadm

User logon
name

sapsidadm

3

Click Next.

4

Enter the password and confirm the password.

5

Select Password never expires.
Ensure that no other option is selected.

6

Click Next.

7

Click Finish.
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Adding the sapsidadm user to the SAP_SAPSID_GlobalAdmin
Group
To add the sapsidadm user to the SAP_SAPSID_GlobalAdmin Group

1

In the Active Directory Users and Computers dialog box, double-click
sapsidadm under Users.

2

In the sapsidadm Properties dialog box, click Member > Add.

3

In the Select Groups dialog box, select SAP_SAPSID_GlobalAdmin

4

Click Add.
Note: By default, this user is also a member of the Domain Users group.

5

Click OK.

To add the SAPServiceSAPSID user to the
SAP_SAPSID_GlobalAdmin Group
To add the SAPSID service user to the SAP_SAPSID_GlobalAdmin Group

1

In the Active Directory Users and Computers dialog box, double-click
SAPServiceSAPSID under Users.

2

In the SAPServiceSAPSID dialog box, click Member > Add.

3

In the Select Groups dialog box, select SAP_SAPSID_GlobalAdmin.

4

Click Add.

5

Remove the user from the Domain users group.
■

From the Member of list, select SAP_SAPSID_GlobalAdmin

■

Select Set Primary Group

■

Select Domain Users

■

Click Remove to delete the Domain Users group from the Member of list

■

Click OK

■

Exit the Active Directory Users and Computers dialog box.

Creating and adding local groups and users
This section describes the procedure to add new local groups and users.
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Note: This procedure may vary for Windows Server 2008
To create a local group

1

Click Start > ControlPanel > Administrativetools > ComputerManagement.

2

In the Computer Management dialog box, select Local Users and Groups.

3

Right-click Group, and select New Group.

4

In the New Group dialog box, enter SAP_SAPSID_LocalAdmin in the Group
name field.

5

Click Add.

6

In the Select Users, Computers or Groups dialog box, enter
domain\SAP_SAPSID_GlobalAdmin in the Object names field.

7

Click OK on the Select Users, Computers, or Groups dialog box.

8

Click OK on the New Group dialog box

To add a domain group to a local group

1

Click Start > ControlPanel > Administrativetools > ComputerManagement.

2

In the Computer Management Console, select Local Users and Groups
>Groups.

3

In the right panel, double-click Administrators.

4

In the Administrators Properties dialog box, click Add.

5

In the Select Users, Computers, or Groups dialog box,
enterdomain\SAP_SAPSID_GlobalAdmin in the Object names field.

6

Click OK in the Select Users, Computers, or Groups dialog box.

7

Click OK in the Administrators Properties dialog box.

Creating sapmnt and saploc share directories
Ensure that the sapmnt and saploc directories are shared, and are accessible by
the SAP system Administrator.
To create the sapmnt and saploc share directories on Windows Server 2003

1

Right-click the drive:\usr\sap directory, and select Properties.

2

In the Properties dialog box, click the Sharing tab.

3

Click Share this folder.

4

Enter sapmnt in the Share name field.

Installing and configuring the SAP WebAS for high availability
Clustering an SAP instance

5

Click Permissions.

6

In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt directory.

7

Click OK in the Permissions for sapmnt dialog box.

8

In the Properties dialog box, click New Share.

9

In the New Share dialog box, enter saploc in the Share name field.

10 Click OK in the New Share dialog box.
11 Click Permissions.
12 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

13 Click OK in the Permissions for saploc dialog box.
14 Click OK in the Properties dialog box.
To create the sapmnt and saploc share directories on Windows Server 2008

1

Right-click the drive:\usr\sap directory, and select properties.

2

On the Properties dialog box, click the Sharing tab.

3

Click Advanced Sharing.

4

Select Share this folder option.

5

Enter sapmnt in the Share name field.

6

Click Permissions.

7

In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt directory.

8

Click OK in the Permissions for sapmnt dialog box.

9

In the Properties dialog box, click Advanced Sharing.

10 On the Advanced Sharing dialog box, click Add.
11 On the New Share dialog box, enter saploc in the Share name field.
12 Click OK in the New Share dialog box.
13 Click Permissions.
14 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

15 Click OK in the Permissions for saploc dialog box.
16 Click OK in the New Share dialog box.
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17 Click OK in the Advanced Sharing dialog box.
18 Click Close in the Properties dialog box.

Configuring the SAP systems on Windows Server 2008
The File Share feature functions differently on Windows Server 2008, as compared
to Windows Server 2003. On Windows Server 2008, you can only access file shares
pointing to local disks with the physical computer name. To be able to define file
shares pointing to shared disks, a “client access point” (one IP address associated
with one network name cluster resource) must already exist in the failover cluster
service group to which the shared disk belongs. Since you can only access file
shares pointing to shared disks with the network name that belongs to the same
failover cluster service group, you can create multiple file shares with the same
file share name (for example, sapmnt) in a failover cluster environment, assuming
the file shares belong to different cluster service groups.
Figure 2-1 shows a typical SAP system installation on a Windows Server 2008
system under VCS environment.
Figure 2-1

Typical SAP system installation (using multiple sapmnt file shares)
on a Windows Server 2008 system under VCS environment
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For sample service group configurations on Windows Server 2008,
See “Sample service group configurations for SAP system on Windows Server
2008” on page 81.
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Chapter

3

Installing, upgrading, and
removing the agent for SAP
WebAS
This chapter includes the following topics:
■

Before you install the agent for SAP WebAS

■

Installing the VCS agent for SAP WebAS

■

Removing the VCS agent for SAP WebAS

■

Upgrading the agent for SAP WebAS

Before you install the agent for SAP WebAS
Ensure that you meet the following prerequisites before installing the agent for
SAP WebAS:
■

Install and configure Veritas Cluster Server.

■

Remove any previous version of this agent.
See “Removing the VCS agent for SAP WebAS” on page 47.

Installing the VCS agent for SAP WebAS
Use the Product Installer to install the agent for SAP WebAS.
Note: Ensure that you have uninstalled the previous version of this agent, if
installed.
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Also note that the agents for both, SAP NetWeaver and SAP WebAS are combined
in a single package. Thus, if you install either of the agent, the other agent gets
installed by default.
To install the VCS agent for SAP WebAS

1

Log on to any node in the cluster.
Ensure that the logged on user has the domain administrative privileges.

2

Download the complete agent pack tarball from FileConnect site:
https://fileconnect.symantec.com/
Alternatively,
Download the individual agent tarball from the Symantec Veritas Operations
Services (VOS) site:
https://vos.symantec.com/home

3

Uncompress the file to a temporary location.

4

If you downloaded the complete Agent Pack tarball, navigate to the directory
containing the package for the platform running in your environment.

5

Windows 2003
(IA64)

cd1/windows/w2k3IA64/vcs/application/
sapwebas_agent/vcs_version/version_agent

Windows 2003
(x64)

cd1/windows/w2k3x64/vcs/application/
sapwebas_agent/vcs_version/version_agent

Windows 2008
(x64)

cd1/windows/w2k8x64/vcs/application/
sapwebas_agent/vcs_version/version_agent

Double-click the Setup.exe file to begin the installation.
You may see a pkgs directory here. Do not start the installation by executing
the vrtsvcssap.msi file in this directory.

6

On the Veritas Product Installer screen, click Veritas High Availability
Agents 5.0.2.0 for SAP NetWeaver.

7

On the Welcome screen, click Next.

8

On the Computer Selection dialog box, in the Computer field, enter the node
name on which you want to install the agents for SAP NetWeaver.
Alternatively,
■

Browse to select the nodes from the domain in which you want to install
the agents for SAP NetWeaver. Select the nodes and click OK.
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9

■

Click Add.

■

Click Next.

On the Validation screen, view the installation status on each of the selected
node and click Next.
Note: An error is displayed, if you have a previous version of this agent
installed.

10 On the Report screen review the summary report and click Install.
The installer displays the installation status during and after the installation.

Removing the VCS agent for SAP WebAS
Perform the following procedure to uninstall the agent for SAP WebAS from a
cluster. Perform these steps while the cluster is active.
Note: The agent for SAP NetWeaver and SAP WebAS are combined in a single
package. Thus, removing one agent package will remove the other by default.
To uninstall the VCS agent for SAP WebAS

1

Ensure that all clustered SAP resources are offline.

2

From the cluster, remove all the resources that use the agents for SAP WebAS.

3

Perform the following steps on each node from which you want to uninstall
the agent. Ensure that you have a user with administrative privileges.
■

Click Start > Settings > Control Panel.

■

Double-click Add/Remove Programs.

■

From the list of programs, select Veritas High Availability Agents 5.0.2.0
for SAP NetWeaver.

4

Click Change/Remove.

5

Follow the instructions that the uninstall program provides, to complete the
uninstallation of the agents for SAP WebAS.
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Upgrading the agent for SAP WebAS
Perform the following steps to upgrade the agent with minimal disruption, in a
VCS environment.
To upgrade the agent in a VCS environment

1

Login as domain administrator.

2

Verify that your path is drive:\Program Files\Veritas\Cluster Server\bin

3

Persistently freeze all the service groups that host the application.
C:\> hagrp –freeze GroupName -persistent

4

Stop the cluster services forcibly.
C:\> hastop -all –force

5

Ensure that the agent operations are stopped on all the nodes.

6

Take a back up of the main.cf and types.cf
C:\> copy drive:\> Program Files\Veritas\Cluster
Server\conf\config\main.cf drive:\>backup\main.cf
C:\> copy drive:\> Program Files\Veritas\Cluster
Server\conf\config\types.cf drive:\>backup\types.cf

7

Uninstall the agent package from all the nodes.
See “Removing the VCS agent for SAP WebAS” on page 47.

8

Install the new agent on all the nodes.
See “Installing the VCS agent for SAP WebAS” on page 45.

9

Navigate to drive:\> Program Files\Veritas\Cluster Server\conf\config\types.cf
file and verify if any duplicate type definitions exists for Weblogic on all the
nodes.
If duplicate type definitions exist, remove old type definition from types.cf
file and save the file.
Note: To identify the old type definition, compare the new type definition file
with the old (backed up) types.cf file.
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10 Check for the changes in the resource values required, if any, due to the new
agent types definition.
Note: To note the list of changed attributes, compare the new type definition
file with the old type definition file.

11 Start VCS on all nodes in the cluster.
C:\> hastart

12 Start the agent on all nodes, if not started.
C:\> haagent -start SAPWebAS -sys SystemName

Optionally, start the SAPNW04 agent,
C:\> haagent -start SAPNW04 -sys SystemName

13 Unfreeze the service groups once all the resources come to an online steady
state.
C:\> hagrp -unfreeze GroupName -persistent
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Configuring the agent for
SAP WebAS
This chapter includes the following topics:
■

About configuring the agent for SAP WebAS

■

Agent attributes for SAPWebAS

■

Setting the SAPMonHome attribute

■

Configuring the execution period for agent functions

■

Executing a custom monitor program

■

Preventing early faulting of Java and Add-In instances

About configuring the agent for SAP WebAS
To provide high availability for SAP NetWeaver 7.10 components in the VCS
environment, you must first configure the VCS resources of type SAPWebAS.
After installing the Agents for SAP NetWeaver, you can create and configure the
SAP resources. Before you configure a resource, review the attributes table that
describes the SAPWebAS resource type and its attribute definitions.
See “Agent attributes for SAPWebAS” on page 51.

Agent attributes for SAPWebAS
Table 4-1 shows the required attributes for configuring a SAP WebAS instance.
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Table 4-1

Required attributes

Required attributes Description
ResLoglevel

The logging detail performed by the agent for the resource. The
valid values are:
INFO: Logs error messages
TRACE: Logs error and trace messages. TRACE is very verbose and
should only be used during initial configuration or for
troubleshooting and diagnostic operations.
Type and dimension: string-scalar
Default: INFO
Example: TRACE

SAPAdmin

Windows user name used to start the SAP instance. This user must
be dedicated to all the SAP instances within an SAP system. The
format is sapsidadm.
Type and dimension: string-scalar
Default: No default value
Example: pil adm

SAPAdminDomain

Windows domain name to which the SAPAdmin user belongs.

Note: If SAPAdmin does not belong to a Windows domain, use the
cluster localization settings to specify the local computer name
for each system.
Type and dimension: string-scalar
Default: No default value
Example: SYMCORP
SAPAdminPassword

Password for the SAPAdmin user.
Use the vcsencrypt -agent command to encrypt the password. If
you are using the VCS GUI, the GUI automatically encrypts the
password.
Type and dimension: string-scalar
Default: No default value
Example: vxfgh28skbsj
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Table 4-1

Required attributes (continued)

Required attributes Description
SAPHost

Virtual IP host name (LANMAN name) for the SAP instance. If the
instance is installed with location hostname, use the local system
name as this attribute value.
Type and dimension: string-scalar
Default: No default value
Example: sappi1scs

SAPHome

The absolute path to the SAP base directory. This attribute is used
to locate programs that the Agent for SAP NetWeaver uses for
start, stop, and clean functions.
Example 1: C:\usr\sap\PI1\DVEBMSG00\exe
Example 2: C:\usr\sap\PI1\ASCS01\exe
Default: No default value

SAPServiceUser

Windows user name used to start the SAP Windows service for an
SAPSID. This user must be dedicated to all the SAP services under
one SAP system, and must not be used by any other SAP service
or instance under a different SAP system, even in the same cluster.

Note: Do not include the domain name in the value for this
attribute. Use the SAPAdminDomain attribute to specify domain
information.
Type and dimension: string-scalar
Default: No default value
Example: SAPServicePI1
SAPSID

SAP system name. This attribute starts with an alphabetic
character and is exactly 3 characters in length. Ensure that the
alphabetic characters used in this attribute are in uppercase only.
SAPSID is defined during the SAP installation.
Type and dimension: string-scalar
Default: No default value
Example: PI1
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Table 4-1

Required attributes (continued)

Required attributes Description
InstType

String identifier that classifies and describes the SAP server
instance type. The InstType values are not case sensitive.
The valid values are:
APPSERV: SAP Application Server
ENQUEUE: SAP Central Services
ENQREP: SAP Enqueue Replication Server
Type and dimension: string-scalar
Default: APPSERV
Example: ENQUEUE

InstName

Uniquely identifies an SAP server instance, along with the SAPSID
attribute. The last two characters of this attribute specify the value
of the InstID attribute. The InstID and SAPSID attributes together
uniquely identify an SAP instance.
Some examples include the following:
■

ASCS03: SAP Central Services (ABAP)

■

SCS07: SAP Central Services (Java)

■

DVEBMGS00: SAP Primary Application Server (ABAP)

■

D05: SAP Additional Application Server (ABAP)

■

J06: SAP (Primary/Additional) Application Server (Java)

■

ERS04: SAP Enqueue Replication server

Type and dimension: string-scalar
Default: ""
Example: DVEBMGS00
InstProfile

Specifies the full path and file name of the SAP Instance Profile.
Typically the InstProfile is found in
C:\usr\sap\SAPSID\SYS\profile and has a name of
SAPSID_InstName_hostname.
Type and dimension: string-scalar
Default: No default value
Example: C:\usr\sap\PI1\SYS\profile\PI1_DVEBMGS00_sappi1pas
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Table 4-1

Required attributes (continued)

Required attributes Description
ProcMon

The list of SAP processes that the monitor function must monitor
during a first-level check of an SAP instance. The entries in this
list are separated using a space and can be specified in any order.
The valid values are:
APPSERV: disp+work.exe igswd.exe jstart.exe gwrd.exe icman.exe
ENQUEUE: msg_server.exe enserver.exe gwrd.exe
ENQREP: enrepserver.exe
Type and dimension: vectar-scalar
Default: No default value
Example: disp+work.exe

SAPMonHome

The directory that defines the location of the sapinfo.exe or
ensmon.exe commands. The agent for SAP WebAS uses these
commands for second-level monitoring.
This functionality is not a part of the base SAP installation. Hence,
the value of this attribute may be different from the SAPHome
attribute.
Type and dimension: string-scalar
Default: No default value
Example: C:\usr\sap\sapinfo\rfcsdk\bin

EnqSrvResName

Specifies the SAP Central Services instance resource name in VCS.
This attribute is set for only Enqueue Replication Server (ERS) and
will be used by both Enqueue and Enqueue Replication Servers to
query others status during startup and failover.
Type and dimension: string-scalar
Default: No default value
Example: SAPPI1SCS_scs

Table 4-2 shows the required attributes for configuring a SAP WebAS instance.
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Table 4-2

Optional attributes

Attribute

Description

SecondLevelMonitor

Used to enable second-level monitoring and specify the interval
for the same. Second-level monitoring is a deeper, more thorough
state check of the configured SAP instance. The numeric value
specifies how often the second-level monitoring routines are run.
0 means never run the second-level monitoring routines, 1 means
run routines every monitor interval, 2 means run routines every
second monitor interval, and so on.

Note: Exercise caution while setting SecondLevelMonitor to large
numbers. For example, if the MonitorInterval is set to 60 seconds
and the SecondLevelMonitor is set to 100, then sapinfo is executed
every 100 minutes, which may not be as often as intended. For
maximum flexibility, no upper limit is defined for
SecondLevelMonitor.
Type and dimension: integer-scalar
Default: 0
Example: 1
MonitorProgram

Full path and file name of an external, user-supplied monitor
program. If specified, the monitor function executes this file to
perform an additional server state check. There are no restrictions
for what actions the external monitor program performs, to
determine the state of a SAP instance server. The only constraint
is that the external monitor program must return one of the
following integer values:
■

0 (server is online)

■

110 (server is online)

■

100 (server is offline)

■

1 (server is offline)

■

99 or any thing else (server state is unknown)

Note: Symantec recommends storing the external monitor
program in the shared disk directory to ensure the file is always
available on the online system. Arguments are supported.
Type and dimension: string-scalar
Default: No default value
Example 1: C:\usr\sap\PI1\DVEBMGS00\work\mymonitor.bat
Example 2: C:\usr\sap\PI1\DVEBMGS00\work\mymonitor.exe
arg1 arg2
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Setting the SAPMonHome attribute
The SAPMonHome attribute contains the absolute path to the directory that
contains the binary used for second level monitoring process.
The binaries that are used during second-level monitoring for different SAP usage
types and SAP instances are as follows:
■

For ABAP application Server: sapinfo.exe
sapinfo.exe is not a standard binary shipped by SAP with installation media.
Customers need to download the latest rfcsdk kit from the following site: http:
//service.sap.com/swdc -> Support Packages and Patches -> Entry by
Application Group -> Additional Components.
For more information on selecting the right RFCSDK for your SAP application,
refer to SAP notes 1005832, 825494 and 413708.

■

For Add-In (ABAP + Java) application server: sapinfo.exe

■

For Enqueue and Enqueue Replication Server: ensmon.exe

Note: For Java application server and java component of Add-In application server
the agent uses the sapcontrol.exe utility prepsent in SAPHome.

Configuring the execution period for agent functions
An agent function is allocated an execution period using the respective time-out
attributes: OnlineTimeout, OfflineTimeout, MonitorTimeout, and CleanTimeout.
By default these values are set to 300, 300, 60 and 60 respectively.
If an agent function executes a program, for example sapinfo.exe, the program
must execute within the allocated execution period. If the program is unable to
execute within the allocated period, the agent function cancels and terminates
the execution of the program. You must set these timeout attributes to appropriate
values depending on the time required for SAP applications. You can modify these
values with the following command.
hatype -modify TypeName attribute_name attribute_value

Example: C:\> hatype -modify SAPWebAS OnlineTimeout 600

Executing a custom monitor program
The monitor function executes a custom monitor program to perform a
user-defined SAP WebAS state check.
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The monitor function executes the MonitorProgram if the following conditions
are true:
■

The specified utility is a valid executable file.

■

The first level process check indicates that the SAP Web AS instance is online.

■

The SecondLevelMonitor attribute is either set to 0 or 1, and the second level
check indicates that the SAP Web AS instance is online.

■

The SecondLevelMonitor attribute is set to greater than 1, but the second level
check is deferred for this monitoring cycle

The monitor operation interprets the program exit code as follows:
110 or 0

SAP server instance is ONLINE

100 or 1

SAP server instance is OFFLINE

99

SAP server instance is UNKNOWN

Any other value

SAP server instance is UNKNOWN

To ensure that the custom monitor program is always available to the agent
application, Symantec recommends storing the file in a shared directory that is
available on an online node.

Preventing early faulting of Java and Add-In instances
When you start a SAP Java or a SAP Add-In Application Server Instance, SAP
automatically starts processes such as jstart.exe. Depending upon the available
resources, starting these processes takes some finite time.
The agent for SAP WebAS allows enough time for SAP to start these processes
successfully. The agent checks the status of these processes in definite intervals.
While checking the status of these processes, if the processes are missing, the
agent pauses for a time period that is equal to one-tenth of the value of the
MonitorTimeout attribute before re-checking the status of the processes.
Symantec strongly recommends that the administrator set the MonitorTimeout
attribute, such that the agent gives enough time for these processes to restart if
a failure occurs.
For example, if an add-in server instance takes 9 seconds to restart a failed jstart
process, you must set the value of the MonitorTimeout attribute to at least 90
seconds.
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Configuring the service
groups for SAP WebAS
This chapter includes the following topics:
■

About configuring service groups for SAP WebAS

■

Before configuring the service groups for SAP WebAS

■

Configuring service groups with SAPWebAS agent

■

Configuring SAPWebAS preonline script

About configuring service groups for SAP WebAS
Configuring the SAP WebAS service group involves creating the SAP service
group, its resources, and defining attribute values for the configured resources.
You must have administrator privileges to create and configure a service group.
You can configure the service groups using one of the following:
■

The Cluster Manager (Java console)

■

The command-line

Before configuring the service groups for SAP WebAS
Before you configure the SAP WebAS service group, you must perform the
following:
■

Verify that VCS is installed and configured on all nodes in the cluster where
you will configure the service group.
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Refer to Veritas Storage Foundation™ and High Availability Solutions
Installation and Upgrade Guide for more information on installing and
configuring VCS.
■

Verify that SAP NetWeaver 7.10 is installed and configured identically on all
nodes in the cluster.
See “About installing SAP WebAS for high availability” on page 25.
See “About configuring SAP WebAS for high availability” on page 26.

■

Verify that the Veritas agents for SAP NetWeaver is installed on all nodes in
the cluster.
See “Installing the VCS agent for SAP WebAS” on page 45.

Configuring service groups with SAPWebAS agent
While setting up a cluster, you must always ensure that the cluster has some spare
capacity to handle the SAP NetWeaver failover scenarios. For example, in case of
a backend database failure, the cluster must be able to run another database
instance in conjunction with other running applications. Review the information
about data protection.
See Veritas Storage Foundation™ and High Availability Solutions Installation and
Upgrade Guide
The cluster should thus be able to provide application failover by encapsulating
the resources required for an application into a service group. A service group is
a virtualized application that can switch between the cluster nodes. It contains a
set of dependent resources, such as disk groups, disk volumes, file systems, IP
addresses, NIC cards, and dependent application processes. It also includes logic
about the dependencies between the application components.
These service groups should thus be configured such that the cluster can start,
stop, monitor, and switch the service groups between the nodes, depending upon
the server or resource faults. An administrator should also be proactively able to
move a service group between cluster nodes to perform preventative maintenance
or apply patches.
To configure the service groups

1

Change the cluster configuration to read/write mode.
C:\> haconf -makerw

2

Create a service group for SAP NetWeaver 7.10
C:\> hagrp -add SAP710-PI1SCS

For more details refer to, Veritas Cluster Server Administrator's Guide
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3

Modify the SystemList attribute for the group, to add systems.
C:\> hagrp -modify SAP710-PI1SCS SystemList vcswin74 0 vcswin75
1

4

Create resources for NIC, IP, Lanman,VMDg and MountV in the service group.
C:\> hares -add SAP710-PI1SCS_nic NIC SAP710-PI1SCS
C:\> hares -add SAP710-PI1SCS_ip IP SAP710-PI1SCS
C:\> hares -add SAP710-PI1SCS_lanman Lanman SAP710-PI1SCS
C:\> hares -add SAP710-PI1SCS_mnt MountV SAP710-PI1SCS
C:\> hares -add SAP710-PI1SCS_vmdg VMDg SAP710-PI1SCS

For more details on creating and modifying resource attributes for NIC, IP,
Lanman, VMDg and MountV refer to, Veritas Cluster Server Bundled Agents
Reference Guide.

5

Create links between the resources.
C:\> hares -link SAP710-PI1SCS_ip SAP710-PI1SCS_nic
C:\> hares -link SAP710-PI1SCS_lanman SAP710-PI1SCS_ip
C:\> hares -link SAP710-PI1SCS_mnt SAP710-PI1SCS_vmdg

6

Create SAPWebAS resource for applications based on SAP NetWeaver 7.10
C:\> hares -add SAP710-PI1SCS_scs SAPWebAS SAP710-PI1SCS

Based on the SAP instance you are clustering, modify the resource attributes.
See “Agent attributes for SAPWebAS” on page 51.

7

Create resource dependencies for SAPWebAS resource.
The SAPWebAS resource depends on the Lanman and MountV resources.
C:\> hares -link SAP710-PI1SCS_scs SAP710-PI1SCS_lanman
C:\> hares -link SAP710-PI1SCS_scs SAP710-PI1SCS_mnt
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8

Verify the final resource dependencies for SAP server group.
Group
SAP710-PI1SCS
SAP710-PI1SCS
SAP710-PI1SCS
SAP710-PI1SCS
SAP710-PI1SCS

9

Parent
SAP710-PI1SCS_scs
SAP710-PI1SCS_scs
SAP710-PI1SCS_ip
SAP710-PI1SCS_lanman
SAP710-PI1SCS_mnt

Child
SAP710-PI1SCS_lanman
SAP710-PI1SCS_mnt
SAP710-PI1SCS_nic
SAP710-PI1SCS_ip
SAP710-PI1SCS_vmdg

Save the cluster configuration.
C:\> haconf -dump -makero

Configuring SAPWebAS preonline script
In a clustered environment, the SAP administrator installs and configures the
SAP Enqueue and SAP Enqueue Replication server. The SAP Enqueue and Enqueue
Replication Servers have the following requisites:
■

If an Enqueue server instance fails, the server must failover to the node in
which the Enqueue Replication server instance is running.

■

If the Enqueue Replication server instance fails, the instance must failover to
a node where Enqueue Server is NOT running.

The SAPWebAS preonline script facilitates proper Enqueue server failover
behavior. The existing VCS preonline script calls the SAPWebAS preonline script.
The SAPWebAS preonline script performs the following tasks:
■

If the service group for which the script is running does not have an Enqueue
server or an Enqueue Replication server resource, the script returns the control
back to the VCS preonline script.

■

If the service group has an Enqueue server or Enqueue Replication server
resource, the script determines the node on which the online operation can
be performed. The script also ensures that the online operation does not execute
the VCS preonline script again.

To accomplish this failover behavior, you must configure the VCS preonline script.
The VCS preonline trigger calls an external preonline trigger utility,
sapwebaspreonline.exe. The initiated preonline trigger performs the steps
necessary for correct failover behavior of the Enqueue servers. The
sapwebaspreonline.exe utility is located in the %VCS_HOME%\bin\SAPWebAS
directory.
To configure SAPWebAS preonline script
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Step 1: Navigate to the %VCS_HOME%\bin\Trigger directory.
Step 2: Add the following lines to the preonline file:
Note: If you are configuring the preonline file for the first time, this file may not
exist. You can thus skip this step.

#-------------------------------------------------------------# Start sapwebas preonline trigger.
#-------------------------------------------------------------# Perl preonline.pl <system> <group> <whyonlining>
<systemwheregroupfaulted>
my $system = $ARGV[0];
my $group = $ARGV[1];
my $whyonlining = $ARGV[2];
my $systemwheregroupfaulted = undef;
my $sArgs = join(' ', @ARGV);
VCSAG_LOG_MSG("I", "Arguments [$sArgs]", 15041);
if(defined $ARGV[3]) {
$systemwheregroupfaulted = $ARGV[3];
}
my $SAPWebASPreOnlineTrigger = sprintf("%s\\bin\\SAPWebAS\\
sapwebaspreonline.exe", $vcs_home);
VCSAG_LOG_MSG("I", "The trigger command is [$SAPPreOnlineTrigger]", 15041);
if(defined $systemwheregroupfaulted)
{
VCSAG_LOG_MSG("I", "The group is faulted on syetem =
[$systemwheregroupfaulted]", 15042);
$CMD = sprintf("\"%s\" %s %s %s %s", $SAPWebASPreOnlineTrigger,
$system, $group, $whyonlining, $systemwheregroupfaulted);
}
else {
$CMD = sprintf("\"%s\" %s %s %s", $SAPWebASPreOnlineTrigger, $system,
$group, $whyonlining);
}
system($CMD);
my $exit_value = $? >> 8;
VCSAG_LOG_MSG("I", "The exit code from the trigger: [$exit_value].",
15046, $exit_value);
if($exit_value == 0) {
VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP executed
successfully.", 15046);
exit;
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}
elsif($exit_value == 1) {
VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP FAILED.", 15047);
exit;
}
else {
VCSAG_LOG_MSG("I", "Unknown PreOnline trigger.", 15048);
}
#-------------------------------------------------------------# End sapwebas preonline trigger.
#-------------------------------------------------------------.
.
# give control back to HAD.
if (defined $ARGV[3]) {
‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys $ARGV[0]
-checkpartial $ARGV[3]‘;
exit;
}
‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys $ARGV[0]‘;
exit;

Step 3: If the preonline file does not exist, copy the sample preonline trigger file
from the %VCS_HOME%\bin\Sample_Triggers directory, in to the
%VCS_HOME%\bin\Triggers directory.
Revert back to step 2 to make changes in the preonline file. A sample
sapwebaspreonline file is also available in the
%VCS_HOME%\bin\Sample_Triggers directory. You can copy this file in the
%VCS_HOME%\bin\Triggers directory, rename the file to preonline, and then
use this file.
Step 4: Set the preonline trigger attribute to true for the Service Groups to which
the Enqueue and Enqueue Replication server instances belongs.
For VCS 5.0 use the following command:
C:\> hagrp -modify service_group PreOnline 1

For VCS 5.1 use the following command on each system:
C:\> hagrp -modify service_group PreOnline 1 -sys system
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The preonline script is now configured to facilitate Enqueue and Enqueue
Replication server behavior. You can view the logs in the VCS engine log,
engine_A.log.
Note: Once the preonline trigger is configured, you may see unexpected behavior
while manually switching or performing online operations on the Enqueue
Replication service group. This behavior is a result of the control logic within the
preonline trigger that protects the Enqueue lock table. For system maintenance,
if you prefer to perform manual operations on the service groups, you can do so
by disabling the preonline trigger.
To disable the preonline trigger, use the following command:
For VCS 5.0,
C:\> hagrp -modify service_group PreOnline 0
For VCS 5.1 use the following command on each system
C:\> hagrp -modify service_group PreOnline 0 -sys system
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Troubleshooting the agent
for SAP WebAS
This chapter includes the following topics:
■

Using correct software and operating system versions

■

Meeting prerequisites

■

Configuring SAP WebAS resources

■

Starting the SAP WebAS outside a cluster

■

Common Problems with Veritas agent for SAP WebAS

■

Reviewing SAP WebAS agent log files

■

Reviewing error log files

■

Checks for an SAP Add-In Usage Types

Using correct software and operating system versions
Ensure that no issues arise due to incorrect software and operating system
versions. For the correct versions of operating system and software to be installed
on the resource systems:
See “Supported software” on page 12.

Meeting prerequisites
Before installing the Veritas agent for SAP WebAS, double check that you meet
the prerequisite requirements. For a list of prerequisites:
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See “Before you install the agent for SAP WebAS” on page 45.

Configuring SAP WebAS resources
Before using an SAP WebAS resource, ensure that you configure the agent
attributes correctly. For more information,
See “Agent attributes for SAPWebAS” on page 51.

Starting the SAP WebAS outside a cluster
If you face problems while working with a resource, you must disable the resource
within the cluster framework. A disabled resource is not under the control of the
cluster framework, and so you can test the SAP WebAS independent of the cluster
framework. Refer to the cluster documentation for information about disabling
a resource. You can then restart the SAP WebAS outside the cluster framework.
Note: Use the same parameters that the resource attributes define within the
cluster framework while restarting the resource outside the framework.
A sample procedure to start a SAP WebAS outside the cluster framework, is
illustrated as follows:
To start a SAP instance outside the cluster framework, using SAP MMC

1

Log in to the system as a sapsidadm user.

2

Use the SAP Microsoft Management Console (MMC) to start the SAP instance.
Ensure that the SAP instance starts successfully. If the instance starts
successfully outside the cluster, you can attempt to start it inside the cluster
framework.
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To start a SAP instance outside the cluster framework, using the command prompt

1

Log in to the system as a sapsidadm user.

2

Start the SAP Windows service SAPSAPSID_xx for SAP instance, using the
following command:.
drive\> net start SAPSAPSID_xx

3

Use the startsap.exe utility to start the SAP instance. Enter,
drive\>usr\sap\SAPSID\InstName\exe\startsap.exe name=SAPSID
nr=InstID sapdiahost=virtual_hostname

Ensure that the SAP instance starts successfully. If the instance starts
successfully outside the cluster, you can attempt to start it inside the cluster
framework.

Common Problems with Veritas agent for SAP WebAS
This section describes some problems that you may face while working with the
Veritas Agent for SAP NetWeaver in a VCS environment.

Unable to install the Veritas Agent for SAP NetWeaver
If you are not able to install the Veritas Agent for SAP NetWeaver, check to see
if previous versions of the agent are present in the system. If present, remove the
older agents and attempt to install the agent again.
Note: Starting 2010Q1 agent pack release, the agents for SAP NetWeaver and
SAPWebAS are combined into a single package. Thus, if an earlier version of VCS
agent for SAP NetWeaver is already installed on the system the agents for SAP
WebAS may not get installed. Ensure that you remove the older versions of the
agent before you begin to install the agent pack from 2010Q1 agent pack release.
Also, ensure that you go through the prerequisites before installing SAP
NetWeaver.
See “Before you install the agent for SAP WebAS” on page 45.

Unable to see an entry in the SAP MMC for an SAP instance
If you cannot see any entry for an SAP instance in the SAP MMC, you must
re-register the SAP services as COM Typelibrary Only.
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To re-register the SAP services

1

At the command prompt, navigate to drive\Program Files\SAP\hostcntl\exe
directory.

2

Run the sapstartsrv.exe command.

3

In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field.
You must re-register the SAP services as described here whenever a change
in the SAP service registration occurs.

The agent for SAP WebAS fails to bring online an SAP instance resource
through VCS
Attempt to start the SAP resource outside the VCS environment to ensure that
the resource is working properly.
See “Starting the SAP WebAS outside a cluster” on page 68.
You can also view the log files to further diagnose the problem.
See “Reviewing SAP WebAS agent log files” on page 72.

SAP instance does not come online, and the startsap.exe command
exits with exit code -1
Check the SAP MMC to ensure that the entry for this SAP instance is present. If
the entry is not present, add the SAP instance in the SAP MMC.
See “Unable to see an entry in the SAP MMC for an SAP instance” on page 69.
Then attempt to bring the SAP instance online.

In case of an Enqueue server failure, the Enqueue server instance fails
to take over the lock table from the Enqueue Replication server instance
If the Enqueue Replication server instance does not recognize the correct Enqueue
server instance, this problem may occur. Ensure that the value of InstID passed
to the Enqueue Replication server process, enrepserver.exe in the start profile,
belongs to the correct Enqueue server instance.
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The ensmon.exe command returns exit code 4 for a Enqueue server
instance
If the Enqueue Replication server is not configured or is not online, this problem
occurs. Ensure that if the Enqueue Replication server is configured, the instance
is online.
If the Enqueue Replication server instance is not configured, disable the replication
parameter in the Instance profile of the Enqueue server instance:
enque/server/replication = false

The return code of the ensmon.exe command is 8 for an Enqueue
Replication server instance
The return code indicates that the Enqueue server instance is down. When the
Enqueue server instance fails, the ensmon.exe command returns this code when
the instance is switching over to the Enqueue Replication server instance to take
over the instate lock table.
Check the state of the Enqueue server instance.

The Enqueue server instance does not fail over to the correct Enqueue
Replication server instance
This problem occurs if the preonline script is not configured properly. To configure
the preonline script:
See “Configuring SAPWebAS preonline script” on page 62.
This problem also occurs if the InstType attribute is not set properly. Also make
sure that you configured EnqSrvResName attribute for Enqueue Replication Server
(ERS) Instance resource.

In case of a resource fault, the Service Group does not fail over
If the resource is not set to critical, the Service Group may not fail over. To resolve
the issue, set the resource to critical.

Agent fails to start after installation
Ensure that you have installed Visual Studio 8 redistributable for Visual studio
runtime on your system. Since the agent is compiled with Microsoft.VC80.CRT
version='8.0.50727.762', it fails to start if Visual Studio 8 redistributable is not
installed.
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To verify if Visual Studio 8 redistributable is installed, access <system
drive>:\WINDOWS\WinSxS. If a folder similar to
<arch>_Microsoft.VC80.CRT_<random_number>_8.0.50727.762_<random_number>

exists, it confirms that the required redistributable is installed.
For example,
amd64_Microsoft.VC80.CRT_1fc8b3b9a1e18e3b_8.0.50727.762_x-ww_9d1c6ce0

In case if the redistributable is not installed, download the Visual studio
re-distributables for VS 2005 SP1 with version VC80.CRT_8.0.50727.762 from
microsoft site at the following locations:
For x64 (amd64)
http://www.microsoft.com/downloads/details.aspx?
familyid=EB4EBE2D-33C0-4A47-9DD4-B9A6D7BD44DA&displaylang=en
For IA64 (Intel64)
http://www.microsoft.com/downloads/details.aspx?
familyid=747AAD7C-5D6B-4432-8186-85DF93DD51A9&displaylang=en

Reviewing SAP WebAS agent log files
If you are facing problems while using the Veritas agent for SAP WebAS or an
SAP server instance, refer to the following sections to access the relevant files
for information about the issue.

Using SAP instance log files
In case of problems while using the Veritas Agent for SAP WebAS, you can access
the SAP instance log files for more information. These log files are located in the
drive:\usr\sap\SAPSID\InstName\work directory.

Using SAP log files
If an SAP server is facing problems, you can access the agent log files to further
diagnose the problem. The log file is drive:\Program Files\VERITAS\Cluster
Server\log\SAPWebAS_A.txt.

Reviewing error log files
If you face problems while using SAP NetWeaver instance or the agent for SAP
WebAS, use the log files described in this section to investigate the problems.
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Using SAP NetWeaver instance files
If a SAP server is facing problems, you can access the server log files to further
diagnose the problem. The SAP log files are located in the
drive\usr\sap\SAPSID\InstName\work directory.

Reviewing cluster log files
In case of problems while using the agent for SAP WebAS, you can access the
engine log file for more information about a particular resource. The engine log
file is located at drive:\Program Files\VERITAS\Cluster Server\log\engine_A.txt.
Additionally, you can also refer to the latest SAPWebAS agent log files located at
drive:\Program Files\VERITAS\Cluster Server\log\SAPWebAS_A.txt.
Note: Include both these log files while addressing the problem to Symantec
support team.

Using trace level logging
The ResLogLevel attribute controls the level of logging that is written in a cluster
log file for each SAP Web AS resource. You can set this attribute to TRACE, which
enables very detailed and verbose logging.
If you set ResLogLevel to TRACE, a very high volume of messages are produced.
Symantec recommends that you localize the ResLogLevel attribute for a particular
resource.
Warning: You may consider to temporarily increase the timeout values for
SAPWebAS for debugging purposes. After the debugging process is complete, you
can revert back to the original timeout values.
To localize ResLogLevel attribute for a resource

1

Identify the resource for which you want to enable detailed logging.

2

Localize the ResLogLevel attribute for the identified resource:
hares -local Resource_Name ResLogLevel

3

Set the ResLogLevel attribute to TRACE for the identified resource:
hares -modify Resource_Name ResLogLevel TRACE -sys SysA

4

Note the time before you begin to operate the identified resource.
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5

Test the identified resource. The function reproduces the problem that you
are attempting to diagnose.

6

Note the time when the problem is reproduced.

7

Set the ResLogLevel attribute back to INFO for the identified resource:
hares -modify Resource_Name ResLogLevel INFO -sys SysA

8

Review the contents of the log file. Use the time noted in Step 4 and Step 6
to diagnose the problem.
You can also contact Symantec support for more help.

Checks for an SAP Add-In Usage Types
For an SAP Add-In system, you must perform the following checks before further
investigations:
■

The SAP resources running the ABAP and Java Central Services instances are
in the same Service Group.

■

The SAP resources running the ABAP and Java Enqueue Replication server
instances, are in the same Service Group.
Note: Symantec recommends to configure the Central Services and Enqueue
Replication server instances for an Add-In usage type in different service
groups to minimize the SPOFs in a service group.

■

Ensure the following:
■

The EnqSrvResName attribute of the Java Enqueue Replication server
instance is set to the VCS resource that is running the corresponding Java
Central Services instance (SCS).

■

The EnqSrvResName attribute of the ABAP Enqueue Replication server
instance is set to the VCS resource that is running the corresponding ABAP
Central Services instance (ASCS).

Appendix
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Sample Configurations
This appendix includes the following topics:
■

About the sample configuration for the agent for SAP WebAS

■

Sample agent type definition for SAP WebAS

■

Sample SAP resource configuration

■

Sample service group configuration for ABAP and Java Usage types

■

Sample service group configurations for SAP system on Windows Server 2008

■

Sample service group dependency for SAP WebAS

About the sample configuration for the agent for SAP
WebAS
The sample configuration depicts the resource types, resources, and resource
dependencies within the Service Group. Review these dependencies carefully
before configuring the agent for SAP WebAS. For more information about these
resource types, see the Veritas Cluster Server Bundled Agents Reference Guide.

Sample agent type definition for SAP WebAS
This section provides the sample agent type definition for SAP WebAS.
type SAPWebAS (
static i18nstr ArgList[] = { ResLogLevel, SAPAdmin, SAPAdminDomain,
SAPAdminPassword,
SAPHome, SAPHost, SAPMonHome, SAPServiceUser, SAPSID, InstName,
InstProfile,
InstType, ProcMon, EnqSrvResName, MonitorProgram, SecondLevelMonitor}
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str
str
str
str
str
str
str
str
str
str
str
str
str
str
str
int
)

ResLogLevel = INFO
SAPAdmin
SAPAdminDomain
SAPAdminPassword
SAPHome
SAPHost
SAPMonHome
SAPServiceUser
SAPSID
InstName
InstProfile
InstType = APPSERV
ProcMon[]
EnqSrvResName
MonitorProgram
SecondLevelMonitor = 0

Sample SAP resource configuration
Given the number of possible SAP resource configurations, this section provides
sample working examples that configure a specific SAP instance for Add-In
installations.

Sample SAP primary application server instance
An excerpt of the main.cf file for a SAP primary application server instance is as
follows.
SAPWebAS SAP710-PI1PAS_sap (
SAPAdmin = pi1adm
SAPAdminDomain = ISV-DOMAIN
SAPAdminPassword = HVNtKVkRWnINjNKnL
SAPHome = "E:\\usr\\sap\\PI1\\DVEBMGS22\\exe"
SAPHost = sappi1pas
SAPMonHome = "E:\\usr\\sap\\rfcsdk\\bin"
SAPServiceUser = SAPServicePI1
SAPSID = PI1
InstName = DVEBMGS22
InstType = APPSERV
InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\
PI1_DVEBMGS22_sappi1pas"
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ProcMon = { "disp+work.exe", "jstart.exe" }
)

Sample SAP additional application server instance
An excerpt of the main.cf file for a SAP additional application server instance is
as follows:
SAPWebAS SAP710-PI1PAS_sap (
SAPAdmin = pi1adm
SAPAdminDomain = ISV-DOMAIN
SAPAdminPassword = HVNtKVkRWnINjNKnL
SAPHome = "E:\\usr\\sap\\PI1\\D23\\exe"
SAPHost = sappi1aas
SAPMonHome = "E:\\usr\\sap\\rfcsdk\\bin"
SAPServiceUser = SAPServicePI1
SAPSID = PI1
InstName = D23
InstType = APPSERV
InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\
SYS\\profile\\PI1_D23_sappi1aas"
ProcMon = { "disp+work.exe", "jstart.exe" }
)

Sample SAP Central Services instance
An excerpt of the main.cf file for an SAP Central Services instance is as follows.
SAPWebAS SAP710-PI1SCS_scs (
Critical = 0
SAPAdmin = pi1adm
SAPAdminDomain = ISV-DOMAIN
SAPAdminPassword = HVNtKVkRWnINjNKnL
SAPHome = "E:\\usr\\sap\\PI1\\ASCS20\\exe"
SAPHost = sappi1scs
SAPMonHome = "E:\\usr\\sap\\PI1\\ASCS20\\exe"
SAPServiceUser = SAPServicePI1
SAPSID = PI1
InstName = ASCS20
InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\
PI1_ASCS20_sappi1scs"
InstType = ENQUEUE
ProcMon = { "msg_server.exe", "enserver.exe" }
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SecondLevelMonitor = 1
)

Sample SAP Enqueue Replication server instance
An excerpt of the main.cf file for a SAP Enqueue Replication server instance is as
follows.
SAPWebAS SAP710-PI1ERS_ers (
Critical = 0
SAPAdmin = pi1adm
SAPAdminDomain = ISV-DOMAIN
SAPAdminPassword = HVNtKVkRWnINjNKnL
SAPHome = "E:\\usr\\sap\\PI1\\ERS24\\exe"
SAPHost = sappi1ers
SAPMonHome = "E:\\usr\\sap\\PI1\\ERS24\\exe"
SAPServiceUser = SAPServicePI1
SAPSID = PI1
InstName = ERS24
InstProfile = "\\\\sappi1scs\\sapmnt\\PI1\\SYS\\profile\\
PI1_ERS24_sappi1ers"
InstType = ENQREP
ProcMon = { "enrepserver.exe" }
EnqSrvResName = SAP710-PI1SCS_scs
SecondLevelMonitor = 1
)

Sample service group configuration for ABAP and
Java Usage types
The service group configuration in a cluster depends on some common
characteristics that must be part of the configuration design.
These characteristics include the following:
■

The SAP application server must be dependent on the database server

■

Each SAP instance (Application Server, Enqueue, and Enqueue Replication)
should have a separate virtual IP address assigned to facilitate network
transparency.

■

Each SAP instance (Application Server, Enqueue and Enqueue Replication)
should be placed on shared disk to facilitate cluster node transparency.
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■

Common file systems to include the profile, global and transaction file systems
should be managed from one or more shared disk objects. These systems must
be available to the SAP application via UNC path with SAPGLOBALHOST.

Figure A-1 shows the service group configuration for Application Server
Figure A-1

Service group configuration for Application Server
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NIC

SAP710-PI1PAS_nic

Figure A-2 shows the service group configuration for SAP Central services instance
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Service group configuration for SAP Central services instance

Figure A-2
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Figure A-3 shows the service group configuration for Enqueue Replication Server
instance
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Service group configuration for Enqueue Replication Server instance

Figure A-3
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Sample service group configurations for SAP system
on Windows Server 2008
This section provides the sample service group configurations and resource
dependency diagrams for SAP systems on Windows Server 2008.

Sample configuration for SAP Central Services Instances service group
for Add-In installation Usage Type
This section provides the VCS main.cf for SAP Central Services Instances service
group for Add-In installation Usage Type.
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group SAP-PI3SCS (
SystemList = { SysA = 0, SysB = 1 }
)
FileShare SAP-PI3SCS_sapmnt_FS (
PathName = "\\usr\\sap"
ShareName = sapmnt
LanmanResName = SAP-PI3SCS_Lanman
MountResName = SAP-PI3SCS_H_MountV
UserPermissions = { "'SAP_LocalAdmin'" = FULL_CONTROL,
"'Administrators'" = FULL_CONTROL,
"'SYMCORP\\SAP_PI3_GlobalAdmin'" = FULL_CONTROL,
"'SAP_PI3_LocalAdmin'" = FULL_CONTROL }
)
IP SAP-PI3SCS_IP (
Address = "10.209.70.30"
SubNetMask = "255.255.252.0"
MACAddress = "00-15-17-63-45-92"
)
Lanman SAP-PI3SCS_Lanman (
VirtualName = sappi3scs
IPResName = SAP-PI3SCS_IP
)
MountV SAP-PI3ASCS_MountV (
MountPath = "I:\\usr\\sap\\PI3\\ASCS29"
VolumeName = PI3ASCS_vol
VMDGResName = SAP-PI3ASCS_VMDg
)
MountV SAP-PI3SCS_MountV (
MountPath = "I:\\usr\\sap\\PI3\\SCS30"
VolumeName = PI3SCS_vol
VMDGResName = SAP-PI3SCS_VMDg
)
MountV SAP-PI3SCS_I_MountV (
MountPath = "I:"
VolumeName = PI3SCS_I_vol
VMDGResName = SAP-PI3SCS_I_VMDg
)
MountV SAP-PI3SYS_MountV (
MountPath = "I:\\usr\\sap\\PI3\\SYS"
VolumeName = PI3SYS_vol
VMDGResName = SAP-PI3SYS_VMDg
)
NIC SAP-PI3SCS_NIC (
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MACAddress = "00-15-17-63-45-92"
)
SAPWebAS SAP-PI3ASCS_SAPWebAS (
SAPSID = PI3
SAPHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"
SAPMonHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"
SAPHost = sappi3scs
ProcMon = { "msg_server.exe", "enserver.exe" }
SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQUEUE
InstName = ASCS29
InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_ASCS29_sappi3scs"
)
SAPWebAS SAP-PI3SCS_SAPWebAS (
SAPSID = PI3
SAPHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"
SAPMonHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"
SAPHost = sappi3scs
ProcMon = { "msg_server.exe", "enserver.exe" }
SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQUEUE
InstName = SCS30
InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_SCS30_sappi3scs"
)
VMDg SAP-PI3SCS_I_VMDg (
DiskGroupName = PI3SCS_I_dg
)
VMDg SAP-PI3ASCS_VMDg (
DiskGroupName = PI3ASCS_dg
)
VMDg SAP-PI3SCS_VMDg (
DiskGroupName = PI3SCS_dg
)
VMDg SAP-PI3SYS_VMDg (
DiskGroupName = PI3SYS_dg
)
SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_Lanman
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SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_I_MountV
SAP-PI3SCS_IP requires SAP-PI3SCS_NIC
SAP-PI3SCS_Lanman requires SAP-PI3SCS_IP
SAP-PI3ASCS_MountV requires SAP-PI3SCS_I_MountV
SAP-PI3ASCS_MountV requires SAP-PI3ASCS_VMDg
SAP-PI3SCS_MountV requires SAP-PI3SCS_I_MountV
SAP-PI3SCS_MountV requires SAP-PI3SCS_VMDg
SAP-PI3SCS_I_MountV requires SAP-PI3SCS_I_VMDg
SAP-PI3SYS_MountV requires SAP-PI3SCS_I_MountV
SAP-PI3SYS_MountV requires SAP-PI3SYS_VMDg
SAP-PI3ASCS_SAPWebAS requires SAP-PI3SCS_sapmnt_FS
SAP-PI3ASCS_SAPWebAS requires SAP-PI3ASCS_MountV
SAP-PI3ASCS_SAPWebAS requires SAP-PI3SYS_MountV
SAP-PI3SCS_SAPWebAS requires SAP-PI3SCS_sapmnt_FS
SAP-PI3SCS_SAPWebAS requires SAP-PI3SCS_MountV
SAP-PI3SCS_SAPWebAS requires SAP-PI3SYS_MountV
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//

resource dependency tree
group SAP-PI3SCS
{
SAPWebAS SAP-PI3ASCS_SAPWebAS
{
FileShare SAP-PI3SCS_sapmnt_FS
{
Lanman SAP-PI3SCS_Lanman
{
IP SAP-PI3SCS_IP
{
NIC SAP-PI3SCS_NIC
}
}
MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}
}
MountV SAP-PI3ASCS_MountV
{
MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}

Sample Configurations
Sample service group configurations for SAP system on Windows Server 2008

//
VMDg SAP-PI3ASCS_VMDg
//
}
//
MountV SAP-PI3SYS_MountV
//
{
//
MountV SAP-PI3SCS_I_MountV
//
{
//
VMDg SAP-PI3SCS_I_VMDg
//
}
//
VMDg SAP-PI3SYS_VMDg
//
}
//
}
// SAPWebAS SAP-PI3SCS_SAPWebAS
//
{
//
FileShare SAP-PI3SCS_sapmnt_FS
//
{
//
Lanman SAP-PI3SCS_Lanman
//
{
//
IP SAP-PI3SCS_IP
//
{
//
NIC SAP-PI3SCS_NIC
//
}
//
}
//
MountV SAP-PI3SCS_I_MountV
//
{
//
VMDg SAP-PI3SCS_I_VMDg
//
}
//
}
//
MountV SAP-PI3SCS_MountV
//
{
//
MountV SAP-PI3SCS_I_MountV
//
{
//
VMDg SAP-PI3SCS_I_VMDg
//
}
//
VMDg SAP-PI3SCS_VMDg
//
}
//
MountV SAP-PI3SYS_MountV
//
{
//
MountV SAP-PI3SCS_I_MountV
//
{
//
VMDg SAP-PI3SCS_I_VMDg
//
}
//
VMDg SAP-PI3SYS_VMDg
//
}
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//
// }

}

Sample resource dependency for SAP Central Services Instances service
group for Add-In installation usage type
Figure A-4 shows the sample resource dependency diagram for SAP Central
Services Instances service group for Add-In installation Usage Type on a Windows
2008 Server.
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Sample resource dependency diagram for SAP Central Services
Instances service group for Add-In installation Usage Type on a
Windows 2008 Server

Figure A-4
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Sample configuration for SAP Enqueue Replication Server Instances
service group for Add-In installation Usage Type
group SAP-PI3ERS (
SystemList = { SysA = 0, SysB = 1 }
)
IP SAP-PI3ERS_IP (
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Address = "10.209.70.31"
SubNetMask = "255.255.252.0"
MACAddress = "00-15-17-63-45-92"
)
Lanman SAP-PI3ERS_Lanman (
VirtualName = sappi3ers
IPResName = SAP-PI3ERS_IP
)
MountV SAP-PI3AERS_MountV (
MountPath = "C:\\usr\\sap\\PI3\\ERS31"
VolumeName = PI3AERS_vol
VMDGResName = SAP-PI3AERS_VMDg
)
MountV SAP-PI3ERS_MountV (
MountPath = "C:\\usr\\sap\\PI3\\ERS32"
VolumeName = PI3ERS_vol
VMDGResName = SAP-PI3ERS_VMDg
)
NIC SAP-PI3ERS_NIC (
MACAddress = "00-15-17-63-45-92"
)
SAPWebAS SAP-PI3AERS_SAPWebAS (
SAPSID = PI3
SAPHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"
SAPMonHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"
SAPHost = sappi3ers
ProcMon = { "enrepserver.exe" }
SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQREP
InstName = ERS31
InstProfile = "\\\\sappi3scs\\sapmnt\\
PI3\\SYS\\profile\\PI3_ERS31_sappi3ers"
EnqSrvResName = SAP-PI3ASCS_SAPWebAS
)
SAPWebAS SAP-PI3ERS_SAPWebAS (
SAPSID = PI3
SAPHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"
SAPMonHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"
SAPHost = sappi3ers
ProcMon = { "enrepserver.exe" }
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SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQREP
InstName = ERS32
InstProfile = "\\\\sappi3scs\\sapmnt\\
PI3\\SYS\\profile\\PI3_ERS32_sappi3ers"
EnqSrvResName = SAP-PI3SCS_SAPWebAS
)
VMDg SAP-PI3AERS_VMDg (
DiskGroupName = PI3AERS_dg
)
VMDg SAP-PI3ERS_VMDg (
DiskGroupName = PI3ERS_dg
)
SAP-PI3ERS_IP requires SAP-PI3ERS_NIC
SAP-PI3ERS_Lanman requires SAP-PI3ERS_IP
SAP-PI3AERS_MountV requires SAP-PI3AERS_VMDg
SAP-PI3ERS_MountV requires SAP-PI3ERS_VMDg
SAP-PI3AERS_SAPWebAS requires SAP-PI3AERS_MountV
SAP-PI3AERS_SAPWebAS requires SAP-PI3ERS_Lanman
SAP-PI3ERS_SAPWebAS requires SAP-PI3ERS_MountV
SAP-PI3ERS_SAPWebAS requires SAP-PI3ERS_Lanman
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//

resource dependency tree
group SAP-PI3ERS
{
SAPWebAS SAP-PI3AERS_SAPWebAS
{
MountV SAP-PI3AERS_MountV
{
VMDg SAP-PI3AERS_VMDg
}
Lanman SAP-PI3ERS_Lanman
{
IP SAP-PI3ERS_IP
{
NIC SAP-PI3ERS_NIC
}
}
}

89

90

Sample Configurations
Sample service group configurations for SAP system on Windows Server 2008

// SAPWebAS SAP-PI3ERS_SAPWebAS
//
{
//
MountV SAP-PI3ERS_MountV
//
{
//
VMDg SAP-PI3ERS_VMDg
//
}
//
Lanman SAP-PI3ERS_Lanman
//
{
//
IP SAP-PI3ERS_IP
//
{
//
NIC SAP-PI3ERS_NIC
//
}
//
}
//
}
// }

Sample resource dependency for SAP Enqueue Replication Server
Instances service group for Add-In installation Usage Type
Figure A-5 shows the sample resource group dependency for SAP Enqueue
Replication Server Instances service group for Add-In installation Usage Type
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Figure A-5

Sample resource group dependency for SAP Enqueue Replication
Server Instances service group for Add-In installation Usage Type
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Sample service group dependency for SAP WebAS
This section includes service groups that show the group dependency for SAP
WebAS.
Figure A-6 shows the sample service group dependency
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Figure A-6

Sample service group dependency
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